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KATA PENGANTAR 
 

 
Pemikiran yang mendasari penulis mewujudkan modul ini sebenarnya banyak sekali. 

Salah satu yang terpenting adalah bagaimana membuat masyarakat Indonesia semakin 

tahu dan mengerti betapa pesatnya perkembangan dunia Teknologi Informasi saat ini 

yang harus diimbangin dengan kemampuan dan peran aktif masyarakat itu sendiri 

terutama peserta diklat. 

Pemakaian komputer sudah masuk disegala aspek kehidupan sehingga membutuhkan 

penambahan beberapa perangkat keras (Hardware) untuk mendukung pemasukkan data 

(Input) dan penampilan hasil olahan data (Output). Hardware tambahan ini dikenal 

dengan sebutan periferal. 

Sebenarnya, sudah banyak buku dan modul mengenai periferal yang memudahkan 

peserta diklat. Tetapi anda perlu menyadari bahwa belajar sesuatu yang baik adalah dari 

awal, step by step. Dengan mengetahui dasarnya, apapun bisa Anda raih. 

Modul ini hadir secara khusus bagi peserta diklat yang ingin mempelajari tentang 

periferal komputer dengan bahasa sederhana dan diuraikan secara bertahap. 

Diharapkan Anda dapat belajar secara singkat, sehingga cepat mahir dalam 

menggunakan periferal. Disarankan dalam mempelajari modul ini sambil mempraktekkan 

pada komputer. Hal ini akan sangat membantu pemahaman Anda dalam mempelajari 

setiap bagian yang dibahas. 

Pembahasan dalam modul ini mencakup : 

●​ Penggunaan Scanner 

●​ Penggunaan Printer 

Akhir kata, pertama-tama penulis ucapkan puji syukur kepada Tuhan Yang Maha Esa 

yang telah memberikan Rahmat dan Hidayahnya kepada penulis dan semua pihak yang 

telah banyak membantu penulis 
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1. PENDAHULUAN 
 

1.​  Deskripsi 
 

Nama Modul : Mengoperasikan Periferal 
Kode Kompetensi : TIK.OP02.002.01 
  TIK.OP02.015.01 
Ruang lingkup isi : Operasional Periferal 
  ●​ Mengoperasikan Printer 
  ●​ Mempergunakan perangkat keras dan 

perangkat lunak untuk memindai dokumen dan 
gambar 

Kaitan Modul : Kompetensi yang harus dikuasai sebelum 
mempelajari modul ini adalah:  
●​ TIK.OPO2.003.01 – Mengoperasikan sistem 

operasi 
Hasil yang 
diharapkan 

: Setelah mempelajari modul ini, peserta didik 
diharapkan dapat : 
a.​ Memasang Scanner, Printer 
b.​ Memasang dan menyiapkan penggunaan 

periferal  yang ada 
c.​ Melakukan instalasi periferal yang ada sampai 

dengan kondisi siap pakai sesuai user manual 
d.​ Melakukan pemilihan opsi customization dan 

konfigurasi periferal sesuai kebutuhan 
pemakaian melalui tools yang digunakan 

e.​ Melakukan deaktivasi peralatan yang ada 
Manfaat di Industri : Setelah mempelajari modul ini, peserta didik 

diharapkan untuk dapat : 
a.​ memahami cara memasang dan menginstal 

peralatan sampai siap digunakan 
b.​ menghemat biaya atas instalisasi periferal 

yang di tambahkan; 
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2.​   Prasyarat 
 

Untuk mempelajari modul ini, maka unit kompetensi dan pengetahuan yang harus 
dikuasai sebelumnya adalah  TIK.OPO2.003.01 – Mengoperasikan sistem 
operasi. 

 

3.​ ​ Petunjuk Penggunaan Modul 
 

1.​ Untuk Peserta Didik. 
1.​ Pemelajaran yang dilaksanakan menggunakan sistem Self Based 

Learning atau sistem pemelajaran mandiri. Diharapkan seluruh peserta 
didik dapat belajar secara aktif dengan mengumpulkan berbagai sumber 
selain modul ini, misalnya melalui majalah, media elektronik maupun 
melalui internet. 

2.​ Dalam modul ini dituntut tersedianya bahan ajar yang lengkap yang 
meliputi : 
a.​ Unit komputer yang siap digunakan; 
b.​ Unit periferal yang digunakan; 
c.​ Buku manual periferal; 
d.​ SOP dalam menghidupkan dan mematikan periferal. 

3.​ Setelah menyelesaikan modul ini, peserta didik dapat melanjutkan ke 
modul selanjutnya, yaitu TIK.OP02.004.01 Mengoperasikan Perangkat 
Lunak Pengolah Kata (wordprocessor) – tingkat dasar. 

4.​ Guru atau instruktur berperan sebagai fasilitator dan pengarah dalam 
semua materi di modul ini, sehingga diharapkan dapat terjadi 
komunikasi timbal balik yang efektif dalam mempercepat proses 
penguasaan kompetensi peserta didik. 

2.​ Peran guru/instruktur dalam proses pemelajaran adalah: 
1.​ membantu peserta didik dalam merencanakan proses belajar, utamanya 

dalam materi-materi yang relatif baru bagi peserta didik; 
2.​ membimbing peserta didik melalui konsep dan tugas-tugas pelatihan 

yang dijelaskan dalam tahap belajar serta jenjang pengetahuan peserta 
didik; 

3.​ membantu peserta didik untuk menentukan dan mengakses sumber 
tambahan lain yang diperlukan untuk belajar; 

4.​ mengorganisasikan kegiatan belajar kelompok jika diperlukan; 
5.​ merencanakan seorang ahli/pendamping guru dari dunia usaha untuk 

membantu jika diperlukan; 
6.​ melaksanakan penilaian dan mencatat pencapaian kemajuan peserta 

didik; 
7.​ menjelaskan kepada peserta didik mengenai bagian yang perlu untuk  

dibenahi dan merundingkan rencana pemelajaran selanjutnya. 

 

4.​ ​ Tujuan Akhir 
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Setelah mempelajari modul ini, peserta didik diharapkan dapat: 

1.​ memahami konsep dasar pengoperasian periferal; 
2.​ memahami konsep menghidupkan, mengoperasikan dan mematikan periferal. 

 

5.​ ​ Cek Kemampuan 
 

Apabila anda dapat menjawab seluruh soal di bawah ini, silahkan langsung 
mengambil unit kompetensi selanjutnya. 

 
1.​ Soal Teori 

 
1.​ Di bawah ini, yang termasuk periferal input adalah…. 

a.​ mouse 
b.​ printer 
c.​ monitor 
d.​ speaker 
e.​ LCD projector 

 
2.​ Port PS/2 digunakan untuk periferal 

a.​ Speaker 
b.​ Monitor 
c.​ Mouse 
d.​ LCD Proyektor 
e.​ Printer 

 
3.​ Periferal output yang menghasilkan hasil cetakan 

a.​ Speaker 
b.​ Monitor 
c.​ Mouse 
d.​ LCD Proyektor 
e.​ Printer 

 
 

4.​ Gambar disamping ini adalah konektor 
a.​ USB 
b.​ DB-9  
c.​ HDD-15 
d.​ PS-2 
e.​ Rj-45 

 

​                                                                
​ ​  
​  
12 
 



 

5.​  Gambar port disamping ini adalah untuk konektor 
a.​ USB 
b.​ DB-9  
c.​ HDD-15 
d.​ PS-2 
e.​ Rj-45 

 
 

2.​ Soal Praktek 
Coba anda identifikasi jenis connector dan pasang periferal berikut : 
keyboard, mouse, monitor, printer, scanner. 
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2. KEGIATAN BELAJAR 1 
 

2.1 Tujuan Pemelajaran  
 

1.​ Siswa dapat memahami konsep dasar pengoperasian periferal 
2.​ Siswa mampu mempersiapkan pra-penyalaan printer 
3.​ Siswa mampu menyalakan dan menyiapkan penggunaan printer 
4.​ Siswa mampu mengoperasikan printer 
5.​ Siswa mematikan printer dan mengamati proses deaktivasi hingga selesai 

 
2.2  Periferal Komputer 
 

​ Periferal merupakan semua peralatan yang terhubung dengan komputer. 
Berdasarkan kegunaannya periferal terbagi dua yaitu:  

1.​ Periferal utama (main peripheral) yaitu peralatan yang harus ada dalam 
mengoperasikan komputer. Contoh periferal utama yaitu: monitor, keyboard dan 
mouse. 

2.​ Periferal pendukung (auxillary peripheral) yaitu peralatan yang tidak mesti ada 
dalam mengoperasikan komputer tetapi diperlukan untuk kegiatan tertentu. 
Contohnya yaitu: printer, scanner, modem, web cam dan lain-lain.  

 
Sedangkan berdasarkan proses kerjanya dalam mendukung pengoperasian 
komputer terbagi menjadi:  

1.​ Perangkat masukan (input), adalah perangkat yang digunakan untuk 
memasukkan data atau perintah ke dalam komputer. Perangkat tersebut antara 
lain keyboard, mouse, scanner, digitizer, kamera digital, microphone, dan periferal 
lainnya 

2.​ Perangkat keluaran (output), adalah peralatan yang kita gunakan untuk 
menampilkan hasil pengolahan data atau perintah yang dilakukan oleh komputer. 
Perangkat tersebut antara lain monitor,  printer, plotter, speaker, dan lain lainnya. 

 
Untuk menghubungkan perangkat input dan perangkat output ke komputer dengan 
menghubungkan dengan kabel ke port yang ada di komputer. Berikut ini gambar 
port-port yang ada di komputer untuk menghubungkan ke konektor periferal. 
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Port  PS/2 Port USB Port Serial Port Pararel 
 

Gambar 3.1  Konektor periferal komputer 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
   

Gambar 3.2   Port konektor periferal komputer 
 
 
1.​ Perangkat Output Printer 
 

Printer merupakan salah satu output periferal komputer yang berfungsi untuk 
menampilkan hasil pekerjaan Anda ke dalam bentuk cetakan di atas kertas. 
Sebelum dapat digunakan, software printer harus terlebih dahulu diinstal ke dalam 
sistem komputer. Berdasarkan operating sistem yang digunakan, beberapa printer 
ada telah tersedia sistem softwarenya pada operating system tetapi ada juga yang 
harus menggunakan tambahan CD installer dari luar sistem operasi.  

 
1.​Jenis – Jenis Printer 
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Secara garis besar,  printer terdiri atas: 
1.​ Dot Matrix Printers, yang bekerja dengan cara hentakan. Jenis printer ini 

sebenarnya menghentakkan tinta diatas karbon untuk membentuk karakter 
dikertas. Printer ini banyak digunakan untuk mencetak slip gaji dan wartel. 
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Cara kerjanya yaitu : 
Didalam kepala printer (printhead) berisi beberapa pin yang bergerak dari kiri 
ke kanan kertas dalam satu baris untuk waktu tertentu. Semakin banyak pin 
yang terdapat pada kepala printer maka hasil cetakan semakin bagus yang 
diberinama Near Letter Quality (NLQ). Adapun jumlah pin yang terdapat pada 
dot matrix, yaitu : 9-pin, 24-pin, 48-pin. Kecepatan untuk dot matrix printer 
dalam pencetakan disebut characters per second (cps). 

 
 
 
 
 
 
 
 
 

Gambar 3.3  Printer Dot Matrix 
 

2.​ Inkjet Printers. Jenis printer ini sering digunakan untuk pencetakan dalam 
jumlah yang sedikit  dan tidak 

mengutamakan kecepatan, 
seperti mencetak surat di 
perkantoran dan di rumah. 

 
 
 
 
 
 
 
 
 

Gambar 3.4  Printer Inkjet 
 

Printer jenis ini bekerja dengan cara menyemprotkan cairan tinta ke kertas. 
Printhead printer inkjet diberi nama piezoelectric printheads. Kualitas hasil 
printer diukur dengan dots per inch (dpi) dan kecepatan mencetaknya diukur 
dengan pages per minute (ppm) 
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Gambar 3.5  Tampilan Cara Kerja Printer Inkjet 
 

3.​ Laser Printers, ialah jenis printer yang menghasilkan cetakan yang baik 
dengan kecepatan tinggi. Printer ini didesain untuk memberikan hasil yang 
bagus dalam pencetakan grafik dan photo. 

 
 
 
 
 
 
 
 

Gambar 3.6  Printer Jenis Laser 
 
 
 
 
 
 
 
 
 
 

Gambar 3.7  Komponen Printer Laser 
 

Printer laser mempunyai 6 (enam) langkah proses kerja, yaitu : 
a.​ Cleaning, yaitu : Ketika tulisan telah dicetak keatas kertas dan drum 

terangkat keatas untuk membersihkan toner yang tersisa dari drum 
b.​ Conditioning, yaitu : Membersihkan tulisan yang tersembunyi dari drum 

untuk menerima tulisan berikutnya 
c.​ Writing, yaitu : menulis tulisan dari drum ke kertas menggunakan sinar 

laser 
d.​ Developing, yaitu : meletakkan tulisan tersembunyi ke dalam drum 
e.​ Transferring, yaitu : menempelkan toner kedalam tulisan tersembunyi 

dalam drum untuk dikirim ke kertas. 
f.​ Fusing, yaitu : untuk memanasi toner yang diletakkan pada kertas agar 

melekat  dengan kuat. 
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Gambar 3.8  Tampilan Cara Kerja Printer Laser 
 

2.​ Jenis Port Pada Printer 
 
Untuk menghubungkan perangkat output ke komputer dengan menghubungkan 
dengan kabel ke port yang ada di komputer. Berikut ini gambar port-port yang ada 
di komputer untuk menghubungkan ke konektor printer 
 

  
 
 
 

Port USB Port Pararel 
 

Gambar 3.9  Konektor periferal printer 
 
2.​  Persiapan Pra-Penyalaan Printer 
 

Sebelum kita melakukan pemasangan printer ke komputer, perlu cek kabel yang 
dibutuhkan printer (kabel power dan kabel data), CD drivernya, serta manual 
booknya. Bila sudah lengkap lakukan penyambungan printer ke komputer. 

 
Cara pemasangan printer. 

1.​ Baca manual book dari printer untuk informasi awal printer, bila printer sudah 
dihubungkan dengan komputer, lakukan langkah berikutnya. 

2.​ Pastikan komputer dalam keadaan tidak hidup. 
3.​ Pastikan juga catu daya printer belum terpasang. 
4.​ Cek jenis konektor yang ada pada Kabel data printer yang menuju ke komputer. 

Yang sering digunakan yaitu kabel dengan konektor paralel dan USB.  
5.​ Sambungkan kabel data printer ke komputer 
6.​ Kemudian sambungkan catu daya 
7.​ Nyalakan power printer (bila tidak ada tombol power, printer sudah aktif ketika catu 

dayanya di sambungkan) 
8.​ Untuk mematikan printer maka tekan tombol power atau apabila tidak ada tombol 

power maka cabut catu dayanya. 
 
Tahap berikutnya adalah melakukan instalasi printer. Sebelum anda menggunakan 
printer diperlukan instalasi printer ke komputer Baca buku petunjuk instalasi printer. 
Pelajari langkah-langkah instalasi printer. 
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Langkah yang digunakan untuk menginstalasi local printer adalah sebagai berikut :  
1.​ Klik  Start > Printers and Faxes > Add a printer 

Selain menggunakan cara diatas, Anda dapat menggunakan perintah : Start > 

Control Panel > Printers and Other Hardware. Di layar akan terlihat jendela 
Printers and Other Hardware, kemudian klilk icon Printers and Faxes. 
 
 
 
 
 
 

Add a printer 
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Gambar 3.10  Tampilan jendela Printers and Faxes 

 
2.​ Kemudian muncul jendela Add Printer Wizard and Faxes 

 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Gambar 
3.11  Tampilan jendela Add Printer Wizard and Faxes 

 
3.​ Klik tombol Next > untuk menampilkan kotak dialog berikutnya.  
■​ Local printer attached to this computer  : jika printer yang diinstalasi hanya 

digunakan untuk printer yang bersangkutan (stand alone). 
■​ A network printer, or a printer attached to another computer : jika printer 

terpasang 
pada 
computer 
yang lain 
dengan 
fasilitas 
jaringan 
(network).  
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Gambar 3.12  Kotak dialog untuk pilihan lokal atau jaringan 
 

4.​ Klik tombol Next > untuk menampilkan kotak dialog berikutnya, kemudian tentukan 
port yang digunakan oleh computer tersebut dengan cara klik pilihan LPT1 pada 
bagian Use the following. Perhatikan gambar dibawah ini, kemudian klik tombol 
Next > untuk menampilkan 
kotak dialog berikutnya.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Gambar 3.13  Kotak Dialog Select a Printer Port 
 

5.​ Tentukan nama perusahaan pembuat printer atau merk printer pada pilihan 
Manufacture. Kemudian pilih model printer yang akan ditambahkan pada pilihan 
Printers. Misalnya Canon pada pilihan Manufacturer dan BJC-3000 pada pilihan 
Printers.  
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Gambar 3.14  Tampilan pilihan jenis printer yang digunakan 
 

Apabila pada daftar pilihan printer tersebut tidak ada, maka Anda dapat memilih 
model printer yang kompetibel dengan printer yang Anda gunakan, pada pilihan 
Have Disk.  
 

6.​ Klik tombol Next > untuk menampilkan kotak dialog berikutnya, kemudian ketikkan 
nama printer yang Anda inginkan pada pilihan Printer Name. Apabila printer yang 
Anda instalasi tersebut akan dijadikan sebagai standard penggunaan printer 
(default printer), maka klik Yes pada bagian do you to use this printer as the 
default printer ?  Perhatikan gambar ini, kemudian klik tombol Next > untuk 
menuju pada kotak dialog Printer Sharing 

 
 
 
 
 

 
 
 

 
 

 
 
 
 

Gambar 3.15  Kotak 
Dialog Pembuatan Nama Printer 
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7.​ Pada kotak dialog Printer Sharing tersebut, Anda dapat menentukan apakah 
printer baru tersebut dapat digunakan bersama dengan pemakai lain dalam 
jaringan (network) ataupun hanya digunakan oleh computer Anda saja. Kemudian 
klik tombol Next > untuk menampilkan kotak dialog Print Test Page.  

8.​ Pada kotak dialog Print Test Page, Anda dapat menentukan apakah akan mencetak 
halaman percobaan (pilihan Yes) atau tidak akan melakukan pencetakan halaman 
percobaan (pilihan No).  

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Gambar 3.16  Kotak Dialog Untuk Tes Printer 
 
 

9.​ Kemudian 
klik tombol Next > 
untuk menampilkan 
kotak dialog 

berikutnya.  
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Gambar 3.17  Kotak Dialog Penginstalan Printer Telah Selesai 
 

10.​ Klik tombol Finish untuk mengakhiri proses instalasi tersebut. Perhatikan tampilan 
berikut yang berisi informasi proses instalasi printer.  

 
1.​ Mengoperasikan Printer 
 

Penggunaan printer harus disesuaikan dengan program yang akan kita gunakan 
dan kita dapat melakukan setting konfigurasinya. 

 
1.​ Mensetting Bentuk Pencetakan 

 
Pada umumnya bentuk pencetakan pada naskah ada dua jenis, yaitu 
bentuk portrait (tegak) dan bentuk landscape (tidur). Bentuk naskah 
tersebut dapat kita lakukan melalui software aplikasi yang kita gunakan 
juga melalui setting printer. Adapun setting melalui printer dapat dilakukan 
dengan cara : 

a.​ Klik menu Start > klik menu Printers and Faxes 
b.​ Klik kanan pada jenis printer yang kita gunakan, lalu muncul menu dibawah 

ini : 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Gambar 3.18  Tampilan menu properties printer 
 

c.​ Klik tombol Printing Preferences… 
d.​ Lalu muncul menu dibawah ini : 
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Gambar 3.19  Tampilan Bentuk Pencetakkan Portrait dan Landscape 
 

e.​ Klik tombol Portrait untuk Tegak dan Landscape untuk tidur 
f.​ Klik tombol OK 
 

2.​  Mengatur Penggunaan Tinta 
 

Pada saat pencetakkan kita berkeinginan untuk menghemat tinta agar 
tidak cepat habis, ini dapat kita lakukan melalui konfigurasi setting printer. 
Adapun caranya, yaitu : 
a.​ Klik menu Start > klik menu Printers and Faxes 
b.​ Klik kanan pada jenis printer yang kita gunakan, lalu muncul menu 

dibawah ini : 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Gambar 3.20  Tampilan menu properties printer 
 

c.​ Klik tombol Printing Preferences… 
d.​ Lalu muncul menu dibawah ini : 
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Gambar 3.21  Tampilan Menu Pengaturan Tinta 
 
e.​ Pada tombol menu Media > pilih menu Transparant 
f.​ Klik tombol OK 
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2.​ Rangkuman Kegiatan Belajar 1 
 

Dari uraian demi uraian diatas maka kita dapat mengambil rangkuman modul 
tentang pengoperasian printer, yaitu : 
●​ Periferal berdasarkan kegunaan dibagi dua, yaitu : 

a.​ Periferal utama (main peripheral), yaitu : peralatan yang harus ada dalam 
mengoperasikan komputer, seperti : monitor, mouse, keyboard. 

b.​ Periferal pendukung (auxillary peripheral), yaitu : peralatan yang tidak mesti 
ada dalam mengoperasikan komputer tetapi diperlukan untuk kegiatan 
tertentu, seperti : printer, scanner, modem, web cam dll 

●​ Periferal berdasarkan cara kerjanya dibagi dua, yaitu : 
a.​ Perangkat masukan (input), yaitu : perangkat yang digunakan untuk 

memasukkan data atau perintah ke dalam komputer, seperti : keyboard, 
mouse, scanner, kamera digital, mircrophone, web cam dll 

b.​ Perangkat keluaran (output), yaitu peralatan yang kita gunakan untuk 
menampilkan hasil pengolahan data atau perintah yang dilakukan oleh 
komputer, seperti : monitor, speaker, plotter, speaker dll. 

●​ Secara umum jenis printer dibagi menjadi tiga, yaitu : 
a.​ Printer Dot Matrix 
b.​ Printer Inkjet 
c.​ Printer Laser 

●​ Jenis-jenis port yang terdapat pada printer, yaitu : 
a.​ Paralel Port 
b.​ USB Port 

●​ Sebelum kita menggunakan printer kita harus menginstall printer tersebut ke 
dalam komputer kita serta mengatur konfigurasi setting yang ada pada komputer 
sesuai dengan keinginan kita. 

 
 
3.​ Tugas Kegiatan Belajar 1 
 

a.​ Installah jenis printer yang ada, dan test print dalam bentuk landscape 
b.​ Installah jenis printer yang ada, dan test print dalam bentuk portrait 
c.​ Aturlah penggunaan tinta untuk jenis transparant 
d.​ Aturlah penggunaan tinta untuk mencetak photo 
e.​ Aturlah jenis kertas untuk ukuran legal 

 
 
4.​ Tes Formatif Kegiatan Belajar 1 
 

1.​ Tes Teori 
 

1.​ Jenis printer yang cara kerjanya menghentakkan jarum di atas pita 
karbon pada kertas, yaitu : 
a.​ Printer dot matrix 
b.​ Printer laser jet 
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c.​ Printer Inkjet 
d.​ Printer buble Jet 
e.​ Printer deskjet 

2.​ Printer jenis apa yang dapat menggunakan kertas bersambung 
(continues form) 
a.​ Printer laser 
b.​ Printer deskjet 
c.​ Printer dot matrix 
d.​ Printer buble jet 
e.​ Printer Ink jet 

 
3.​ Istilah kualitas pencetakkan yang digunakan untuk printer, yaitu… 

a.​ dbi 
b.​ rpm 
c.​ ppm 
d.​ kbps 
e.​ cps 

 
4.​ Bacaan "Number of copies", pada menu print berguna untuk… 

a.​ Menentukan jumlah cetakan yang diinginkan 
b.​ Mencetak halaman tertentu 
c.​ Mengatur penggunaan tinta printer 
d.​ Mencetak seluruh halaman 
e.​ Mencetak halaman yang aktif 

 
5.​ Urutan awal penginstalan printer, yaitu… 

a.​ Klik File > Klik Printers and Faxes > Klik Add a printer 
b.​ Klik Start > Klik Printers and Faxes > Klik Add a printer 
c.​ Klik Printers and Faxes > Klik Start > Klik Add a printer 
d.​ Klik Edit > Klik Printers and Faxes > Klik Add a printer 
e.​ Klik Tools > Klik Printers and Faxes > Klik Add a printer 

 
 

2.7.2  Tes Praktek 
 

1.​ Lakukan cara mencetak dengan menggunakan kertas bersambung 
(continues form) pada printer ? 

2.​ Bagaimanakah caranya apabila kita ingin mencetak halaman 3, 5, 10-15 
saja ? 

3.​ Agar printer kita menjadi default (printer standard), bagaimana langkah 
yang harus dilakukan ? 

4.​ Bagaimana caranya tiba-tiba kita ingin membatalkan printer yang sedang 
berjalan ? 

5.​ Bagaimanakah caranya apabila kita ingin mencetak isi file Data.Txt 
melalui mode teks (DOS) ? 
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